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Introduction

The Cassegrain form of this telescope is an evolution of the camera designed by Bernhard 
Schmidt in 1929. The original ‘Schmidt Camera’ featured a thin aspheric plate placed at 
the center of curvature of the spherical primary mirror which was able to eliminate 
spherical aberration. The Schmidt-Cassegrain telescope featured in this tutorial has a 
spherical secondary mirror that is intended to be mounted on the inside of the aspheric 
corrector plate. Although this results in some residual off-axis coma and focal plane 
curvature, the overall form is extremely compact. Telescopes based on this design are 
widely used in the amateur astronomical community.

The Schmidt-Cassegrain telescope demonstrated in this tutorial uses an aspheric corrector 
lens and two spherical mirrors. The aspheric corrector is created using the Aspheric Even 
Lens 3D part from the Ray Optics Module Part Library. The spherical parts use the 
Spherical Mirror 3D part. An overview of the telescope can be seen in Figure 1.

Another closely related catadioptric telescope model, the Gregory-Maksutov Telescope, 
can also be found in the COMSOL Ray Optics Module Application Library.

Figure 1: Overview of the Schmidt-Cassegrain telescope.
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Model Definition

Details of the Schmidt-Cassegrain telescope used in this example can be found in Ref. 1. 
The chosen design has a 203.2 mm diameter entrance pupil and an f/10 focal ratio. The 
nominal optical prescription is given in Table 1.

The telescope geometry is constructed using parts from the Ray Optics Module Part 
Library. The Schmidt corrector is created using an instance of the Aspheric Even Lens 3D 
part, whereas the Spherical Mirror 3D part is used to create the primary and secondary 
mirrors. Note that the optical prescription has been reformatted to allow these parts to be 
defined in a somewhat arbitrary sequence; that is, the order in which optical elements are 
placed in a COMSOL geometry sequence does not affect the ray trace. However, the 
optical elements can be placed relative to one another by making use of built-in work-
planes in each of the Part Instances.

The resulting Schmidt-Cassegrain telescope geometry sequence is shown in Figure 2. 
Detailed instructions for creating the geometry can be found in Appendix — Geometry 
Instructions.

The default Physics-controlled mesh should be slightly refined in order to reduce the 
effects of discretization. The mesh used in this simulation can be seen in Figure 3.

TABLE 1:  SCHMIDT-CASSEGRAIN TELESCOPE OPTICAL PRESCRIPTION.

Identity Details Material Radius 
(mm)

Thickness 
(mm)

Diameter 
(mm)

Object — — Infinity 0

1 Reference surface — — 50.0000 0

2 Central obstruction — — 10.0000 70.0

Stop Corrector lens, entr. N-BK7 — 4.0000 203.2000

4 Corrector lens, exita

a. Even asphere. Coefficients are: A4 = 6.431003e-10, A6 = 3.11397e-16. Units are mm.

— −56,118.2800 7.0000 203.2458

5 Secondary mirror 
ref.

— — 303.8701 0

6 Primary mirrorb

b. Primary mirror central hole diameter: dhole = 50.0000 mm.

Mirror −812.8000 −303.8701 206.1674

7 Secondary mirror Mirror −252.6581 303.8701 53.9204

8 Primary mirror ref. — — 200.0000 0

Image Image surface — — — 17.8789
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Figure 2: The Schmidt-Cassegrain telescope geometry sequence.

Figure 3: The Schmidt-Cassegrain telescope mesh.
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Results and Discussion

A ray trace has been performed using three wavelengths (486 nm, 546 nm, and 656 nm) 
at three field angles (0, 0.125, and 0.25 degrees). Figure 4 shows the resulting ray 
trajectories; the Color Expression represents the ray positions on the image surface.

In Figure 5 the intersection of the rays with the image surface is shown. This spot diagram 
shows each of the three field angles, where the Color Expression is the wavelength.

Figure 4: Ray diagram for the Schmidt-Cassegrain telescope colored by radial distance from 
the centroid.
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Figure 5: Spot diagram for the Schmidt-Cassegrain telescope colored by wavelength. The Airy 
disc is shown for reference in the lower-left corner.
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Application Library path: Ray_Optics_Module/Lenses_Cameras_and_Telescopes/
schmidt_cassegrain_telescope

Modeling Instructions

From the File menu, choose New.

N E W

In the New window, click Model Wizard.
6 |  S C H M I D T - C A S S E G R A I N  T E L E S C O P E



M O D E L  W I Z A R D

1 In the Model Wizard window, click 3D.

2 In the Select Physics tree, select Optics>Ray Optics>Geometrical Optics (gop).

3 Click Add.

4 Click Study.

5 In the Select Study tree, select Preset Studies for Selected Physics Interfaces>Ray Tracing.

6 Click Done.

G L O B A L  D E F I N I T I O N S

Parameters 1: Lens Prescription
1 In the Model Builder window, under Global Definitions click Parameters 1.

2 In the Settings window for Parameters, type Parameters 1: Lens Prescription in 
the Label text field. The lens prescription will be added when the geometry sequence is 
inserted in the following section.

Parameters 2: General
The simulation parameters can be loaded from a text file.

1 In the Home toolbar, click Parameters and choose Add>Parameters.

2 In the Settings window for Parameters, type Parameters 2: General in the Label text 
field.

3 Locate the Parameters section. Click Load from File.

4 Browse to the model’s Application Libraries folder and double-click the file 
schmidt_cassegrain_telescope_parameters.txt.

C O M P O N E N T  1  ( C O M P 1 )

1 In the Model Builder window, click Component 1 (comp1).

2 In the Settings window for Component, locate the General section.

3 Find the Mesh frame coordinates subsection. From the Geometry shape function list, 
choose Cubic Lagrange. The ray tracing algorithm used by the Geometrical Optics 
interface computes the refracted ray direction based on a discretized geometry via the 
underlying finite element mesh. A cubic geometry shape order usually introduces less 
discretization error compared to the default, which uses linear and quadratic 
polynomials.
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Insert the prepared geometry sequence from file. You can read the instructions for creating 
the geometry in the appendix. Following insertion, the lens definitions will be available in 
the Parameters node.

1 In the Model Builder window, under Component 1 (comp1) click Geometry 1.

2 In the Settings window for Geometry, locate the Units section.

3 From the Length unit list, choose mm.

4 In the Label text field, type Schmidt-Cassegrain Telescope.

5 In the Geometry toolbar, click Insert Sequence.

6 Browse to the model’s Application Libraries folder and double-click the file 
schmidt_cassegrain_telescope_geom_sequence.mph.

7 In the Geometry toolbar, click Build All.

8 Click the Orthographic Projection button in the Graphics toolbar. Compare the 
resulting geometry to Figure 2.

A D D  M A T E R I A L

1 In the Home toolbar, click Add Material to open the Add Material window.

2 Go to the Add Material window.

3 In the tree, select Optical>Glasses>Optical Glass: Schott>Schott N-BK7®.

4 Click Add to Component in the window toolbar.

5 In the Home toolbar, click Add Material to close the Add Material window.

M A T E R I A L S

Schott N-BK7® (mat1)
1 In the Settings window for Material, locate the Geometric Entity Selection section.

2 From the Selection list, choose All (Corrector).

G E O M E T R I C A L  O P T I C S  ( G O P )

1 In the Model Builder window, under Component 1 (comp1) click Geometrical Optics (gop).

2 Select Domain 2 only.

3 In the Settings window for Geometrical Optics, locate the Ray Release and Propagation 
section.

4 From the Wavelength distribution of released rays list, choose Polychromatic,

specify vacuum wavelength.
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5 In the Maximum number of secondary rays text field, type 0. In this simulation stray light 
is not being traced, so reflected rays will not be produced at the lens surfaces.

6 Select the Use geometry normals for ray-boundary interactions check box. In this 
simulation, the geometry normals are used to apply the boundary conditions on all 
refracting surfaces. This is appropriate for the highest accuracy ray traces in single-
physics simulations, where the geometry is not deformed.

Medium Properties 1
1 In the Model Builder window, under Component 1 (comp1)>Geometrical Optics (gop) click 

Medium Properties 1.

2 In the Settings window for Medium Properties, locate the Medium Properties section.

3 From the Refractive index of domains list, choose Get dispersion model from material. 
The material added above contains the optical dispersion coefficients which can be used 
to compute the refractive index as a function of wavelength.

Material Discontinuity 1
1 In the Model Builder window, click Material Discontinuity 1.

2 In the Settings window for Material Discontinuity, locate the Rays to Release section.

3 From the Release reflected rays list, choose Never.

Mirrors
1 In the Physics toolbar, click Boundaries and choose Mirror.

2 In the Settings window for Mirror, type Mirrors in the Label text field.

3 Locate the Boundary Selection section. From the Selection list, choose Mirrors.

Obstructions
1 In the Physics toolbar, click Boundaries and choose Wall.

2 In the Settings window for Wall, type Obstructions in the Label text field.

3 Locate the Boundary Selection section. From the Selection list, choose Obstructions.

4 Locate the Wall Condition section. From the Wall condition list, choose Disappear.

Image
1 In the Physics toolbar, click Boundaries and choose Wall.

2 In the Settings window for Wall, type Image in the Label text field.

3 Locate the Boundary Selection section. From the Selection list, choose All (Image plane).
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Release from Grid 1
Release rays from a set of hexapolar grids using quantities defined in the Parameters 2: 

General node.

1 In the Physics toolbar, click Global and choose Release from Grid.

2 In the Settings window for Release from Grid, locate the Initial Coordinates section.

3 From the Grid type list, choose Hexapolar.

4 Specify the qc vector as

5 Specify the rc vector as

6 In the Rc text field, type P_nom/2.

7 In the Nc text field, type N_ring.

8 Locate the Ray Direction Vector section. Specify the L0 vector as

9 Locate the Vacuum Wavelength section. From the Distribution function list, choose 
List of values.

10 In the Values text field, type lam1 lam2 lam3. These wavelengths were defined in the 
Parameters 2: General node.

Release from Grid 2
1 Right-click Release from Grid 1 and choose Duplicate.

2 In the Settings window for Release from Grid, locate the Initial Coordinates section.

dx1 x

dy1 y

dz z

0 x

0 y

1 z

vx1 x

vy1 y

vz z
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3 Specify the qc vector as

4 Locate the Ray Direction Vector section. Specify the L0 vector as

Release from Grid 3
1 Right-click Release from Grid 2 and choose Duplicate.

2 In the Settings window for Release from Grid, locate the Initial Coordinates section.

3 Specify the qc vector as

4 Locate the Ray Direction Vector section. Specify the L0 vector as

M E S H  1

1 In the Model Builder window, under Component 1 (comp1) click Mesh 1.

2 In the Settings window for Mesh, locate the Physics-Controlled Mesh section.

3 From the Element size list, choose Finer. Slightly refine the mesh to improve the ray 
tracing accuracy.

4 Click Build All. The mesh should look like Figure 3.

S T U D Y  1

Step 1: Ray Tracing
1 In the Model Builder window, under Study 1 click Step 1: Ray Tracing.

2 In the Settings window for Ray Tracing, locate the Study Settings section.

3 From the Time-step specification list, choose Specify maximum path length.

4 From the Length unit list, choose mm.

5 In the Lengths text field, type 0 1250.

dx2 x

dy2 y

vx2 x

vy2 y

dx3 x

dy3 y

vx3 x

vy3 y
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6 In the Home toolbar, click Compute.

R E S U L T S

Ray Diagram
Now, make some modifications to the default Ray Trajectories plot.

1 In the Settings window for 3D Plot Group, type Ray Diagram in the Label text field.

2 Locate the Color Legend section. Select the Show units check box.

Ray Trajectories 1
In the Model Builder window, expand the Ray Diagram node.

Color Expression 1
1 In the Model Builder window, expand the Ray Trajectories 1 node, then click 

Color Expression 1.

2 In the Settings window for Color Expression, locate the Expression section.

3 In the Expression text field, type at('last',gop.rrel). This expression gives the 
radial distance from the centroid of the spot on the image plane generated by each 
release feature.

4 From the Unit list, choose µm.

Filter 1
1 In the Model Builder window, click Filter 1.

2 In the Settings window for Filter, locate the Ray Selection section.

3 From the Rays to include list, choose Logical expression.

4 In the Logical expression for inclusion text field, type at(0,atan2(qy,qx)>-pi/2). 
This filter removes 1/4 of the rays so that the optical geometry is visible.

Ray Diagram
In the following we add and color surface plots to show the various telescope optical 
elements.

Surface 1
1 In the Model Builder window, right-click Ray Diagram and choose Surface.

2 In the Settings window for Surface, locate the Coloring and Style section.

3 From the Coloring list, choose Uniform.

4 From the Color list, choose Gray.
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Selection 1
1 Right-click Surface 1 and choose Selection.

2 In the Settings window for Selection, locate the Selection section.

3 From the Selection list, choose Mirrors.

Surface 2
In the Model Builder window, under Results>Ray Diagram right-click Surface 1 and choose 
Duplicate.

Selection 1
1 In the Model Builder window, expand the Surface 2 node, then click Selection 1.

2 In the Settings window for Selection, locate the Selection section.

3 From the Selection list, choose Obstructions.

Surface 2
1 In the Model Builder window, click Surface 2.

2 In the Settings window for Surface, locate the Coloring and Style section.

3 From the Color list, choose Custom.

4 On Windows, click the colored bar underneath, or — if you are running the cross-
platform desktop — the Color button.

5 Click Define custom colors.

6 Set the RGB values to 105, 105, and 105, respectively.

7 Click Add to custom colors.

8 Click Show color palette only or OK on the cross-platform desktop.

Surface 3
Right-click Results>Ray Diagram>Surface 2 and choose Duplicate.

Selection 1
1 In the Model Builder window, expand the Surface 3 node, then click Selection 1.

2 In the Settings window for Selection, locate the Selection section.

3 From the Selection list, choose Clear Apertures.

Surface 3
1 In the Model Builder window, click Surface 3.

2 In the Settings window for Surface, locate the Coloring and Style section.

3 On Windows, click the colored bar underneath, or — if you are running the cross-
platform desktop — the Color button.
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4 Click Define custom colors.

5 Set the RGB values to 54, 140, and 203, respectively.

6 Click Add to custom colors.

7 Click Show color palette only or OK on the cross-platform desktop.

Transparency 1
1 Right-click Surface 3 and choose Transparency.

2 In the Ray Diagram toolbar, click Plot.

3 Click the Zoom Extents button in the Graphics toolbar. Compare the resulting 
image to Figure 4.

Spot Diagram
1 In the Home toolbar, click Add Plot Group and choose 2D Plot Group.

2 In the Settings window for 2D Plot Group, type Spot Diagram in the Label text field.

3 Locate the Color Legend section. Select the Show units check box.

Spot Diagram 1
1 In the Spot Diagram toolbar, click More Plots and choose Spot Diagram.

2 In the Settings window for Spot Diagram, locate the Layout section.

3 From the Origin location list, choose Average over area. This option centers each spot on 
the midpoint of all rays.

4 Click to expand the Annotations section. Select the Show circle check box.

5 In the Radius text field, type r_Airy.

Color Expression 1
1 Right-click Spot Diagram 1 and choose Color Expression.

2 In the Settings window for Color Expression, locate the Expression section.

3 In the Expression text field, type gop.lambda0.

4 From the Unit list, choose nm.

5 Click to expand the Range section. Select the Manual color range check box.

6 In the Minimum text field, type 425.

7 In the Maximum text field, type 675.

8 Locate the Coloring and Style section. From the Color table list, choose Spectrum.

9 In the Spot Diagram toolbar, click Plot.

10 Click the Zoom Extents button in the Graphics toolbar. Compare the resulting 
image to Figure 5.
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Appendix — Geometry Instructions

From the File menu, choose New.

N E W

In the New window, click Model Wizard.

M O D E L  W I Z A R D

1 In the Model Wizard window, click 3D.

2 Click Done.

S C H M I D T - C A S S E G R A I N  T E L E S C O P E  G E O M E T R Y  S E Q U E N C E

1 In the Model Builder window, under Component 1 (comp1) click Geometry 1.

2 In the Settings window for Geometry, type Schmidt-Cassegrain Telescope 
Geometry Sequence in the Label text field.

3 Locate the Units section. From the Length unit list, choose mm.

G L O B A L  D E F I N I T I O N S

Parameters 1
1 In the Model Builder window, under Global Definitions click Parameters 1.

2 In the Settings window for Parameters, locate the Parameters section.

3 Click Load from File.

4 Browse to the model’s Application Libraries folder and double-click the file 
schmidt_cassegrain_telescope_geom_sequence_parameters.txt. This file 
contains details of the telescope optical prescription.

We now insert parts from the Ray Optics Parts Libraries which can be used to create each 
of the telescope optical elements. Begin by inserting the corrector lens.

P A R T  L I B R A R I E S

1 In the Home toolbar, click Windows and choose Part Libraries.

2 In the Model Builder window, under Component 1 (comp1) click Schmidt-

Cassegrain Telescope Geometry Sequence.

3 In the Part Libraries window, select Ray Optics Module>3D>Aspheric Lenses>

aspheric_even_lens_3d in the tree.

4 Click Add to Geometry.
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5 In the Select Part Variant dialog box, select Specify clear aperture diameter in the 
Select part variant list.

6 Click OK.

S C H M I D T - C A S S E G R A I N  T E L E S C O P E  G E O M E T R Y  S E Q U E N C E

Corrector
1 In the Model Builder window, under Component 1 (comp1)>Schmidt-

Cassegrain Telescope Geometry Sequence click Aspheric Even Lens 3D 1 (pi1).

2 In the Settings window for Part Instance, type Corrector in the Label text field.

3 Locate the Input Parameters section. In the table, enter the following settings:

Name Expression Value Description

R1 R1_corr 0 m Radius of curvature, surface 1 (+
convex/-concave)

R2 R2_corr -56118 mm Radius of curvature, surface 2 (-
convex/+concave)

k1 0 0 Conic constant, surface 1

k2 0 0 Conic constant, surface 2

A_norm 1[mm] 1 mm Aspheric normalization unit

A02_1 0 0 2nd order aspheric term, surface 1

A04_1 0 0 4th order aspheric term, surface 1

A06_1 0 0 6th order aspheric term, surface 1

A08_1 0 0 8th order aspheric term, surface 1

A10_1 0 0 10th order aspheric term, surface 1

A12_1 0 0 12th order aspheric term, surface 1

A14_1 0 0 14th order aspheric term, surface 1

A16_1 0 0 16th order aspheric term, surface 1

A18_1 0 0 18th order aspheric term, surface 1

A20_1 0 0 20th order aspheric term, surface 1

A22_1 0 0 22nd order aspheric term, surface 1

A02_2 0 0 2nd order aspheric term, surface 2

A04_2 A04_corr 6.431E-10 4th order aspheric term, surface 2

A06_2 A06_corr 3.114E-16 6th order aspheric term, surface 2

A08_2 0 0 8th order aspheric term, surface 2
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Next, create the primary and secondary mirrors.

P A R T  L I B R A R I E S

1 In the Home toolbar, click Windows and choose Part Libraries.

2 In the Model Builder window, click Schmidt-Cassegrain Telescope Geometry Sequence.

3 In the Part Libraries window, select Ray Optics Module>3D>Mirrors>spherical_mirror_3d 
in the tree.

4 Click Add to Geometry.

5 In the Select Part Variant dialog box, select Specify clear aperture diameter in the 
Select part variant list.

6 Click OK.

S C H M I D T - C A S S E G R A I N  T E L E S C O P E  G E O M E T R Y  S E Q U E N C E

Secondary mirror
1 In the Model Builder window, under Component 1 (comp1)>Schmidt-

Cassegrain Telescope Geometry Sequence click Spherical Mirror 3D 1 (pi2).

2 In the Settings window for Part Instance, type Secondary mirror in the Label text field.

A10_2 0 0 10th order aspheric term, surface 2

A12_2 0 0 12th order aspheric term, surface 2

A14_2 0 0 14th order aspheric term, surface 2

A16_2 0 0 16th order aspheric term, surface 2

A18_2 0 0 18th order aspheric term, surface 2

A20_2 0 0 20th order aspheric term, surface 2

A22_2 0 0 22nd order aspheric term, surface 2

Tc Tc_corr 4 mm Center thickness

d0 d0_corr 210 mm Lens full diameter

d1 0 0 m Diameter, surface 1

d2 0 0 m Diameter, surface 2

d1_clear 0 0 m Clear aperture diameter, surface 1

d2_clear 0 0 m Clear aperture diameter, surface 2

nix nix 0 Local optical axis, x-component

niy niy 0 Local optical axis, y-component

niz niz -1 Local optical axis, z-component

Name Expression Value Description
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3 Locate the Input Parameters section. In the table, enter the following settings:

4 Locate the Position and Orientation of Output section. Find the 
Coordinate system to match subsection. From the Take work plane from list, choose 
Corrector (pi1).

5 From the Work plane list, choose Surface 2 vertex intersection (wp2).

6 Find the Displacement subsection. In the zw text field, type z_sec.

Primary mirror
1 In the Geometry toolbar, click Parts and choose Spherical Mirror 3D.

2 In the Settings window for Part Instance, type Primary mirror in the Label text field.

3 Locate the Input Parameters section. In the table, enter the following settings:

4 Locate the Position and Orientation of Output section. Find the 
Coordinate system to match subsection. From the Take work plane from list, choose 
Secondary mirror (pi2).

5 From the Work plane list, choose Mirror vertex intersection (wp1).

Name Expression Value Description

R R_sec 252.66 mm Radius of curvature (+convex/-
concave)

Tc Tc_sec 7 mm Center thickness

d0 d0_sec 60 mm Mirror full diameter

d1 0 0 m Mirror surface diameter

d_clear 0 0 m Clear aperture diameter

d_hole 0 0 m Center hole diameter

niz -1 -1 Local optical axis, z-component

Name Expression Value Description

R R_prim -812.8 mm Radius of curvature (+convex/-
concave)

Tc Tc_prim 20 mm Center thickness

d0 d0_prim 215 mm Mirror full diameter

d1 d1_prim 206.17 mm Mirror surface diameter

d_clear 0 0 m Clear aperture diameter

d_hole dh_prim 50 mm Center hole diameter

niz -1 -1 Local optical axis, z-component
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6 Find the Displacement subsection. In the zw text field, type z_prim.

Finally, create the image plane and central obstruction.

P A R T  L I B R A R I E S

1 In the Geometry toolbar, click Parts and choose Part Libraries.

2 In the Model Builder window, click Schmidt-Cassegrain Telescope Geometry Sequence.

3 In the Part Libraries window, select Ray Optics Module>3D>Apertures and Obstructions>

circular_planar_annulus in the tree.

4 Click Add to Geometry.

S C H M I D T - C A S S E G R A I N  T E L E S C O P E  G E O M E T R Y  S E Q U E N C E

Image plane
1 In the Model Builder window, under Component 1 (comp1)>Schmidt-

Cassegrain Telescope Geometry Sequence click Circular Planar Annulus 1 (pi4).

2 In the Settings window for Part Instance, type Image plane in the Label text field.

3 Locate the Input Parameters section. In the table, enter the following settings:

4 Locate the Position and Orientation of Output section. Find the 
Coordinate system to match subsection. From the Take work plane from list, choose 
Primary mirror (pi3).

5 From the Work plane list, choose Mirror vertex intersection (wp1).

6 Find the Displacement subsection. In the zw text field, type z_img.

Central obstruction
1 In the Geometry toolbar, click Parts and choose Circular Planar Annulus.

2 In the Settings window for Part Instance, type Central obstruction in the Label text 
field.

3 Locate the Input Parameters section. In the table, enter the following settings:

Name Expression Value Description

d0 d_img 40 mm Diameter, outer

d1 0 0 m Diameter, inner

Name Expression Value Description

d0 d_obs 70 mm Diameter, outer

d1 0 0 m Diameter, inner
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4 Locate the Position and Orientation of Output section. Find the 
Coordinate system to match subsection. From the Take work plane from list, choose 
Corrector (pi1).

5 From the Work plane list, choose Surface 1 vertex intersection (wp1).

6 Find the Displacement subsection. In the zw text field, type z_obs.

7 Click Build All Objects.

8 Click the Orthographic Projection button in the Graphics toolbar.

9 Click the Zoom Extents button in the Graphics toolbar.

In the following sections we create selections that can be used to define the physics and 
during postprocessing.

Corrector (pi1)
1 In the Model Builder window, click Corrector (pi1).

2 In the Settings window for Part Instance, click to expand the Domain Selections section.

3 In the table, select the Keep check box for All.

4 Click to expand the Boundary Selections section. Click to select row number 2 in the 
table.

5 Click New Cumulative Selection.

6 In the New Cumulative Selection dialog box, type Clear Apertures in the Name text 
field.

7 Click OK.

8 In the Settings window for Part Instance, locate the Boundary Selections section.

9 In the table, enter the following settings:

10 Click to select row number 4 in the table.

11 Click New Cumulative Selection.

12 In the New Cumulative Selection dialog box, type Obstructions in the Name text field.

13 Click OK.

14 In the Settings window for Part Instance, locate the Boundary Selections section.

Name Keep Physics Contribute to

Surface 1 √ Clear Apertures

Surface 2 √ Clear Apertures
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15 In the table, enter the following settings:

Secondary mirror (pi2)
1 In the Model Builder window, click Secondary mirror (pi2).

2 In the Settings window for Part Instance, locate the Boundary Selections section.

3 Click to select row number 2 in the table.

4 Click New Cumulative Selection.

5 In the New Cumulative Selection dialog box, type Mirrors in the Name text field.

6 Click OK.

7 In the Settings window for Part Instance, locate the Boundary Selections section.

8 In the table, enter the following settings:

Primary mirror (pi3)
1 In the Model Builder window, click Primary mirror (pi3).

2 In the Settings window for Part Instance, locate the Boundary Selections section.

3 In the table, enter the following settings:

Image plane (pi4)
1 In the Model Builder window, click Image plane (pi4).

2 In the Settings window for Part Instance, locate the Boundary Selections section.

3 In the table, select the Keep check box for All.

Name Keep Physics Contribute to

Surface 1 obstruction √ Obstructions

Surface 2 obstruction √ Obstructions

Edges √ Obstructions

Name Keep Physics Contribute to

Mirror surface √ Mirrors

Mirror rear surface √ Obstructions

Mirror edges √ Obstructions

Name Keep Physics Contribute to

Mirror surface √ Mirrors

Mirror rear surface √ Obstructions

Mirror edges √ Obstructions
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Central obstruction (pi5)
1 In the Model Builder window, click Central obstruction (pi5).

2 In the Settings window for Part Instance, locate the Boundary Selections section.

3 In the table, enter the following settings:

Name Keep Physics Contribute to

All √ Obstructions
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